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Chapter 1:  Introduction  
Welcome to Server Technology’s Sentry Power Manager!  

The Sentry Power Manager (SPM) provides real-time enterprise power management of Cabinet Distribution Units (CDUs) 
in one or more remote data center locations.  

As a secure software application on the web, Sentry Power Manager communicates with networked and discovered CDUs. 
Sentry Power Manager’s graphical interface allows monitoring and management of remote CDUs in all locations of your 
entire network from a single console. 

Sentry Power Manager gives a top-level view of the data center and allows drill down to the critical operational details of 
each cabinet and CDU. You can visualize, monitor, and optimize enterprise devices, and generate data reports and trend 
graphs by customized time frame and parameters. 

Top Features of Sentry Power Manager: 

• Real-time CDU status and notification of alarms reported dynamically (using SNMP traps), 
    to allow monitoring and immediate outlet control over CDU operating conditions, including 
    power, temperature, and humidity.  

• Generation of several informational highly-accurate energy usage reports based on individual  outlets, devices, groups 
 (outlets/cabinets), or the entire data center. 

• Server Technology’s “clustering” technology allows the gathering (clustering) of CDUs across 
    individual IP addresses, multiple CDUs, and the entire data center for power monitoring. Reported 
   data can be used for calculating data center efficiency. 

• Custom trend graphs can be generated with a mix of various critical operating parameters, such as 
    temperature, humidity, infeed load, and power.  

• Visualize the network by configuring a custom view of the data center as a hierarchy of levels, 
    such as locations, buildings, floors, rooms, and other specific areas with imported background 
    maps and custom images. Place cabinet and CDU icons on the images to view equipment  conditions graphically 
by status, load, power, and capacity. Click icons on the maps to drill down  from higher data center levels to detailed 
CDU operating parameters.  

 

Technical Support  

 
Experience Server Technology's FREE SMARTER Technical Support - Learn more...

Server Technology understands that there are often questions when installing and/or using a new product.  Free Technical 
Support is provided from 6:00 AM to 7:00 PM, Monday-Friday, Pacific Time. 

Server Technology, Inc. 
1040 Sandhill Drive Tel: 775.284.2000 Web: www.servertech.com 
Reno, Nevada  89521 USA Fax:  775.284.2065 Email: support@servertech.com 
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Chapter 2: Getting Started  
For the administrator: The following list summarizes the step-by-step tasks to help you quickly configure Sentry Power 
Manager (SPM) to build a graphical data center view, user base, and device connections. The configurations allow 
connection and communication with your current established network. 

NOTE: Before you begin, make sure you have enabled SNMP.  

Connect and Login 
Connect to Sentry Power Manager 

Upon connection to Sentry Power Manager, a web browser is directed to the local host name or IP address of the Sentry 
Power Manager server. You then login as the default administrative user with username/password: admn/admn.  

Create a New Administrative Account 
Create a new administrative user account with Config > Users on page 61. 

For security, it is recommended that you first use the default admn user account to grant access rights to another 
administrative user account. Then using the new administrative account, change (or delete) the default admn user account. 
The admn account cannot be demoted or deleted until you have already granted administrative access rights to another 
user account. 

Discover Network Devices 
Configure supported devices for discovery with Config > CDUs > Discover CDUs on page 52. 

Device management starts with adding Cabinet Distribution Units (CDUs) to the SPM network inventory. The Discovery 
feature allows the adding of devices in bulk (IP address range) by searching for SNMP-enabled CDUs across multiple 
subnets in the network for communication with SPM. 

Configure Device Settings  
Locations: Configure locations with Config > Locations on page 48. 

Import, configure, and manage default maps and custom images to be displayed on the Views page as the background for 
location, cabinet, and device icons. 

Cabinets: Configure cabinets with Config > Cabinets on page 55. 

Manage cabinets by adding, editing, and deleting; specify cabinet area (in square ft.) for calculation of system wattage; 
associate a cabinet with a location (background) image. 

CDUs: OPTIONAL. Add a single CDU by its IP address with Config > CDUs > Add CDU on page 54. 

The Add CDU function allows adding one CDU at a time by exact IP address to the network. This is the same function as 
Config > Discover CDUs, but Add CDU is a manual function available as a convenience after bulk discovery when a 
single CDU or a few CDUs need to be added. 

CDUs: Configure CDUs with Config > CDUs > Configure CDUs on page 55. 

Configure CDUs by IP address by naming the CDU, establishing SNMP Get/Set parameters, providing device capacity, 
deleting CDUs, and associating a CDU with a cabinet/location.  

CDUs: OPTIONAL. Configure Environmental Monitor with Config > CDUs > Environmental Monitors 
on page 56. 

If an Environmental Monitor is connected to a CDU, the name of the environmental monitor and its sensors can be edited, 
and sensor high/low thresholds for temperature and humidity can be set . 

CDUs: Configure Enclosures using Config > CDUs > Enclosures on page 57. 

Edit the names of enclosures, infeeds, and outlets for an individual CDU, and configure the power load of the enclosure (in 
amperes). 
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Configure User Groups and Grant Device Permissions 

Create user groups at Config > User Groups on page 63. 

Create a new user group and assign the user group to an access rights level (user type), such as administrative, regular 
user, view-only, or reboot-only. For user type descriptions, see About User Types on page 47. 

Assign user group permissions to networked devices at Config > Group Permissions on page 69. 

When you create a new user group, you are prompted by the device permissions page to grant access rights by individual 
user group (or by all user groups) to networked clusters, locations, cabinets, CDUs, and outlets.  

Configure New Users 
Create a new user and assign to a user group at Config > Users on page 61. 

Create a new user and password. Assign the new user to a user group created in with Config > User Groups above. All 
access rights granted for the user group to networked clusters, locations, cabinets, CDUs, and outlets will be applied to the 
new user.  

Build a Graphical Data Center 
Select maps and images for Views page at Config > Locations on page 48. 

Select default maps or your own custom images as the graphical background to depict customized levels of your data 
center. 

Place a location icon  on a location (background) image at Config > Locations on page 48. 

Associate a location icon with a location (background) image and position the icon on the image using the Views page. 

Place a cabinet icon  on a location (background) image at Config > Cabinets on page 50. 

Associate a cabinet with a location image and position the icon on the image using the Views page. 

Place a CDU icon  on a location (background) image at Config > CDUs > Configure CDUs on page 55. 

Associate a CDU with a location image and position the icon on the image using the Views page. 

Optional Features 
You can configure the following optional features of SPM in any order: 

Outlet Groups/Outlet Clusters 

Configure outlet groups/outlet clusters at Config > Clusters on page 58. 

Create outlet groups and/or outlet clusters for remote reboot and power information. Grant access for locations, CDUs, and 
outlets to the outlet group/outlet cluster.  

Light Directory Access Protocol (LDAP) 

  Configure LDAP parameters at Config > LDAP on page 66. 

LDAP support enables authentication with LDAP servers so that user accounts do not need to be individually created 
locally on each Sentry CDU. 

Email Notification 

Configure email notifications at Config > Email on page 74.  

Configure email notifications for the SPM logs: Discovery, User Login, User Actions, and Alarm Status.  

Access Network Settings 

 Determine Access settings at Config > Access on page 76. 

The Access feature lets SPM connect to, and communicate with, your current established network. Access provides the 
basic configuration options for setting up SPM as an appliance without the need to configure through the operating system. 
The connectivity options are configuration for web, serial port, and Telnet. 
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Backup 

 Determine Access settings at Config > Backup on page 75. 

The Backup feature gives the administrator a database backup function that extracts SPM system data from the database 
and compresses the data to a file. The Backup feature creates the SPMDBackup.sti file for storage on the SPM appliance. 
If needed, the SPMDBackup.sti file can manually be used to restore the SPM database. 

Open Database Connectivity (ODBC) 

SPM provides external access via ODBC to other systems. Access is one way only: data can be retrieved but not updated 
from an external source. 

The ODBC connectivity is a method for using database management systems, independent of programming languages, 
database access, and operating systems. 

NOTE: To purchase the ODBC option, please contact your Server Technology representative at 1-800-835-1515 (domestic), ++0 (1) 
775.284.2000 (international), or sales@servertech.com. 
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System Requirements 

For the Web Browser 
The web browser requirements for Sentry Power Manager are: 

• Internet Explorer 6.0+ (Service Pack 1) or Firefox 2.0+ 

• Recommended screen resolution: 1024 x 768 

Connecting to Sentry Power Manager 
Connecting to Sentry Power Manager requires directing a web browser to the local host name or IP address of the Sentry 
Power Manager server. 

Using the Web Connection 
Connect to the Sentry Power Manager default IP address at: http://192.168.1.254.  

The Login Page 
Connection to Sentry Power Manager displays the following login page: 

 

The username/password for the default administrative account is admn/admn.  
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Working with the Interface  

The following sections introduce the pages and features of the Sentry Power Manager (SPM) interface and provide 
instructions for using enterprise management functions. 

Touring the Views Menu 
The following Views option provides access to Sentry Power Manager functions:   

Views Menu Options 
Option Description 

Views Provides at-a-glace monitoring of enterprise locations, cabinets, and CDUs using colored-coded icons positioned 
on background (location) images. The Views page displays networked equipment by the vantage points of 
operating status, load, power, temperature, humidity, or capacity. 

The administrative login to SPM displays the following Views page as the graphical overview of your data center. The 
page allows point-and-click monitoring of network status and control of discovered devices.   

 

Using Location Images 
Maps and other images are the backgrounds on the Views page where you place icons to depict various locations and 
devices in your data center. Location images represent data center levels as you want to customize those levels, such as 
buildings, floors, and rooms.   

In the example above, a round (location) icon was placed on the default global map to represent a specific data center 
location. The color of the icon is based on the values displayed in the Legend at the bottom of the page. The icon in the 
example is a location containing a device in Critical (red) status.  

The default global map and other default maps are installed with SPM, however, you can import your own graphics files 
(JPG, PNG, or GIF formats only) to use as custom location images.   

NOTE: The administrative login has full access to default maps and any other custom location images. However, new users have limited access 
to the Views menu until granted access rights by the administrator with Config > Users and Config > Group Permissions. 
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Acknowledging Alarms and CDU Status 

The Status box is the real-time and graphical reporting of alarms and status changes occurring in a 
discovered CDU that is monitored by Sentry Power Manager (SPM).  

As an SNMP TRAP destination for the Sentry Switched and Smart CDU, Sentry Power Manager 
can enable the distribution of device alarm notifications and status reporting throughout the system. 

The Status box displays in a fixed size and position in the left pane of the SPM interface. As a 
CDU communicates its status to SPM, the status is reported in one of five categories shown in the 
Status box. SPM only reports status as received from a discovered CDU, and the operating 
condition of the CDU determines the severity of the status category. 

Each status category in the Status box is represented by an icon, the category name, and the total number of CDUs 
(in red for Critical and Warning) currently reported in the category.  

To acknowledge a CDU reported in the Status box, click the icon for the category. The CDU > Manage page opens and 
displays the operating details of the reported CDU where you can review and manage the current condition of the CDU. 

The condition of a CDU is reported in one of five categories: 

Status Categories 
Status Description 

Critical CDU is in a critical (not Normal) alarm status based on SNMP traps sent and requires user action. 

Warning CDU is in a warning state indicating a change in outlet status. 

Unreachable SPM is unable to communicate with the CDU. 

Normal CDU does not show alarm conditions or reported outlet status changes. 

Maintenance An alarm has been acknowledged and the CDU placed in the Maintenance category; the CDU remains in 
Maintenance (for the time period specified or until manually removed), and then returns to its original status 
category; connection can still be made to the CDU; the CDU is monitored and receives SNMP traps; active 
warnings and critical alarms are displayed in the Reason field/More link, but alarms do not cause a status change. 

Choosing Location Images for the Data Center 
The drop-down list in the upper left of the Views page provides the graphic files installed with SPM, as well as any 
custom graphic files the administrator has added (in JPG, PNG, or GIF formats only) using Config > Locations. 

Any graphic files (maps or custom images) in the list are the backgrounds that represent different levels – or locations – of 
your data center, such as a building, floor, room, or other specific area. 

 
The background files display in the drop-down list by their assigned name. The image file you select provides the working 
background where you place icons representing data center locations, cabinets, and CDUs.  

In the previous example, “Continental USA” was selected as the location image, showing two round location icons that 
were placed by the administrator to represent a data center location in Nevada (containing a device in Critical red status) 
and a location in California (containing a device in Normal green status). The images available in the list are determined 
by the administrator. 

The levels of the data center in location images can range from global maps to detailed images, depending on how the 
administrator decides to represent the data center network. By selecting a location image from the drop-down list and 
viewing the graphical status of device icons, an SPM user can quickly monitor and/or manage the data center, based on 
user access rights. 
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Monitoring the Current View 

The drop-down list at the top of the Views page provides the six different views of a CDU for any location image selected 
from the location drop-down list.  

For example, if “Continental USA” was selected as the location image, then the devices on the image can be monitored by 
any of the six views, as the “Temperature” view was selected in the following illustration: 

 
The six views are based on different variables as measured and reported by the CDU for its current status, load, power, 
temperature, humidity, and capacity. The views are fixed and cannot be configured but they allow quick, visual monitoring 
of a location, cabinet, or CDU by color. 

Each view you select corresponds to a value range displayed in the Legend shown at the bottom of the Views page. For 
example, the “Temperature” view selected in the above example automatically displays the temperature value range for 
each of the four icons on the map 

 
Based on the colored location icons and the matching color ranges in the Legend for the Temperature view, you can 
quickly determine the temperature of a CDU in a specific data center location.  

Some CDUs do not support all types of data. For example, if temperature data is not available from the CDU to be 
measured and reported, the icon on the location image will be gray to correspond to the gray label “N/A” in the Legend. 
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A CDU can be monitored by any of the following vantage points: 

CDU Current Views  
View Description 

Status Status of the CDU: Critical, Warning, Unreachable, Maintenance, or Normal. 

Load Load of the CDU in amperes. 

Power Power reporting from the CDU in watts. 

Temperature Temperature of the CDU in degrees Celsius. 

Humidity Relative humidity of the CDU in percentage. 

Capacity Input load capacity used by the CDU in amperes. 

Controlling the Views Page Layout 
For the administrator: The following buttons appear in a row at the top of the Views page to control displaying parent 
location, establishing home location, and moving icons around the location image: 

Views Page – Buttons  
Button Description 

 
Go to the parent of this location. From the displayed location image on the Views page, move up one level in the 
configured hierarchy of location images. For example, move up from the “Nevada” map to the “Continental USA” map. 

 
Set this location as the home location. Sets the current Views page location image as the default home location 
and prompts to confirm. Same as the Home View button in the left pane. 

 
Edit/move icons. Click this button and move location, cabinet, and CDU icons around the current location image to 
position them as desired, and then click Save or Cancel. 

 
Save layout changes. After positioning location, cabinet, and CDU icons on the current location image, to save your 
changes, click the Save button. 

 
Cancel layout changes. After positioning location, cabinet, and CDU icons on the current location image, to cancel 
your changes, click Cancel icon. 
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Introducing the Current View Legends 
The Legend displays at the bottom of the Views page in response to the current CDU view you selected from the drop-
down list: Status, Load, Power, Temperature, Humidity, or Capacity. A unique Legend displays for each CDU view.  
Legends and their colors and ranges are fixed and cannot be changed.   

As a CDU reports its current operating status or other measurable conditions, the colors of the location, cabinet, and CDU 
icons displayed on the location images change to match the color value ranges in the Legend. By comparing an icon color 
to a color range in the Legend, you can visually monitor a specific CDU in the data center. 

Legends and color range values are shown as follows for the current CDU view. Note that if a CDU view, for example, 
Humidity, does not apply to an icon, the icon displays gray on the location image on the Views page as shown in the 
Legend as “N/A”. 

Status  
The colors in the Status view indicate the current condition (status) of the CDU: 

 

Load  
The color range in the Load view indicates the number of amperes used by the CDU: 

 

Power  
The color range in the Power view indicates the watts reading of the CDU: 

 

Temperature  
The color range in the Temperature view indicates the temperature of the CDU (in degrees Celsius): 

 

Humidity  
The color range in the Humidity view indicates the humidity of the CDU (in percentage): 

 

Capacity  
The color range in the Capacity view indicates the input load capacity used by the CDU (in percentage): 
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Example of Legends and Current Views 

The following example shows the Status view selected from the drop-down menu and the coordinating Status Legend. The 
two red icons indicate locations in Critical status; the single yellow icon indicates a location in Warning status. 

 

The following example shows the Humidity view selected from the drop-down menu and the coordinating Humidity 
Legend. The location icons have now changed color to represent their humidity condition, reflected in the value ranges in 
the Legend. 

 
The Legend remains displayed until you select a different CDU view from the drop-down list.  

Viewing the Symbols (Icons) Legend 
The Symbols legend on the Views page shows the three designated shapes for the location, cabinet, and CDU icons that 
you can place on the location image in the Views page to represent your data center.    

 
The three symbols (icon) types are fixed and cannot be changed. To place icons on the background image in the Views 
page, use the Configuration menu options for Locations, Cabinets, and CDUs. For more information, see Working with 
Icons on page 22
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Searching for a CDU  

The Search box is available in the left pane of the SPM 
interface to provide a search utility to find a desired 
device in the network.  

 
 

You can search by IP address or by the name of a CDU, 
enclosure, infeed, outlet, or environmental monitor.  

To start the search, click the down arrow and select the 
type of name from the drop-down list, such as Outlet 
Name has been selected in this example: 

 
 

As you start typing the outlet name in the box, a resulting 
list of matches displays. 

 
 

Select a name in the list and click Search. The detailed search results are displayed on the Enclosure Name page. For 
example, for the outlet “Cisco_6509_8700W_B(10.1.2.137)”, you would see: 

 
  

NOTE: The default CDU name is the IP address of the CDU that you can change using Configuration > CDUs > Configure CDUs.  
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Setting the Home Location  

1. To set a location image in the Views page as your home location, display the desired location image from the 
locations drop-down list on the Views page. 

2. Click the “Set this location as the home location” button on the Views page.   

3. Confirm the change: 

   
4. The current image will remain as your home location, even after logging off from SPM. 

Click the Home View button from any SPM page to return to the Views page and 
display the location image you set as your home page.   

Returning to the Home View 

Click the Home View button from any SPM page to return to the Views page and 
display the background image you set as your home page.   

Using Buttons on the Views Page 
For the administrator: The following buttons appear in a row at the top of the Views page to control displaying parent 
location, establishing home location, and moving icons around the background image: 

Views Page – Buttons  
Button Description 

 
Go to the parent of this location. From the displayed background image on the Views page, 
move up one level in the configured hierarchy of background images. For example, move up from 
the “Nevada” map to the “Continental USA” map (if so configured). 

 
Set this location as the home location. Sets the current Views page background image as the 
default home location and prompts to confirm. Same as the Home View button in the left pane. 

 
Edit/move icons. Click this icon, move location, cabinet, and CDU icons around the current 
background image as desired, then click Save or Cancel icon. 

 
Save layout changes. After repositioning location, cabinet, and CDU icons on the current 
background image, to save repositioning, click Save icon. 

 
Cancel layout changes. After repositioning location, cabinet, and CDU icons on the current 
background image, to undo repositioning, click Cancel icon. 
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Building a Network Map 

For the administrator: SPM offers location, cabinet, and CDU icons to represent the levels of your data center. You can 
place icons for each level on location (background) images on the Views page. The way you customize these levels 
determines the hierarchy of your data center displayed on the Views page. 

For instructions, see Working with the Icons on page 22. 

NOTE: The administrator login has full access to all default and custom images and icons. The administrator must grant each user account access 
to individual location images and icons using Config > Users. 

Working with Data Center Levels: Location, Cabinet, and CDU 
Clicking an icon displayed on a location image drills down to a lower level to show device operating details, allowing you 
to monitor and control outlets, depending on your user access rights. 

The Location Level 
The location icon  on a location (background) image represents a location, such as a city, state, place, building, floor, 
room, or other area or level specific to your data center.  

The following example shows three location icons placed by the administrator on the default location image named 
Continental USA.  

 
Based on the CDU “Status” View at the top of the page, and the color ranges in the corresponding Legend at the bottom of 
the page, you can determine the status of CDUs in these locations. 

To identify a location, roll the mouse pointer over the location icon, shown as follows for the location named “Nevada” 
which contains a CDU in Critical (red) status: 
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To drill down from the Continental USA background image to the location named “Nevada”, click the Nevada icon to 
display the Nevada background image: 

 
The above example shows the Nevada location has a cabinet named “RJF002” in Critical (red) status and provides a 
snapshot of the current reported data in the six views: status, load, power, temperature, humidity, and capacity.  

Click the cabinet icon to drill down to the cabinet identification and operational details: 
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The Cabinet Level 

The cabinet icon  on a location image represents a specific cabinet in your data center.  

The following example shows a cabinet icon placed by the administrator on the data center location image named Beta: 

 
The Status view shows the cabinet, named 001_A, in Normal (green) status. To drill down to the  operational details listed 
for the cabinet, click the cabinet icon.  
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The CDU Level 

The CDU icon  on a background image represents a specific CDU in your data center. The following example shows a 
CDU named “10.1.1.74” placed by the administrator on the background image Data Center1: 

 
Click the CDU icon “10.1.1.74” to drill down to the Enclosure Name page that shows details about the CDU and allows 
command control for its associated outlets. 

 
The Enclosure Name page displays the latest power readings for individual outlet status, load, voltage, power, and control 
state. The page lets you monitor and control power to individual (or all) outlets displayed for the CDU named.  

Outlets are sorted on the page by outlet name under the infeed and enclosure names of the CDU. You can control each of 
the outlets on a Switched CDU individually by issuing the On, Off, and Reboot control actions. For command information, 
see Managing and Controlling Outlets on page 28. 
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Working with the Icons 

The administrator has the permission level to place location, cabinet, and CDU icons on background images that display 
on the Views page. The layouts of background maps represent the customized levels of the data center and the current 
condition of network devices. 

To Place a Location Icon  
1. Select the menu option Config > Locations. 

2. From the Location drop-down list, select a background map that you want associated with a specific data center 
location shown on the Configure Locations page. 

3. Click Apply Changes. 

4. Select the menu option Views. 

5. From the location drop-down list on the Views page, select the background map that you associated with the data 
center location. The round location icon  displays on the background map. Rolling over the icon identifies the 
location by name. 

6. Click the Edit/Move button . All icons on the background map turn light blue. 

7. Click and drag the data center location icon to the desired position on the background map. 

8. Click the Save button  or the Cancel button . If saved, the data center location icon appears in its new position 
on the map, and any other icons on the map change back to their previous colors. If canceled, the map layout will not 
be changed.  

To Place a Cabinet Icon  
1. Select the menu option Config > Cabinets. 

2. From the Location drop-down list, select a location that you want associated with a specific cabinet shown on the 
Configure Cabinets page. 

3. Click Apply Changes. 

4. Select the menu option Views. 

5. From the location drop-down list on the Views page, select the background map that you associated with the cabinet. 

The triangle cabinet icon  displays on the background map. Rolling over the icon identifies the cabinet by name. 

6. Click the Edit/Move button . All icons on the background map turn light blue. 

7. Click and drag the cabinet icon to the desired position on the background map. 

8. Click the Save button  or the Cancel button . If saved, the cabinet icon appears in its new position on the map, 
and any other icons on the map change back to their previous colors. If canceled, the map layout will not be changed.  
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To Place a CDU Icon  

1. Select the menu option Config > CDUs > Configure CDUs. 

2. From the Cabinet/Location drop-down list, select a location that you want associated with a specific CDU shown on 
the Configure CDUs page. 

3. Click Apply Changes. 

4. Select the menu option Views. 

5. From the location drop-down list on the Views page, select the background map that you associated with the CDU. 

The rectangular CDU icon  displays on the background map. Rolling over the icon identifies the CDU by name. 

6. Click the Edit/Move button . All icons on the background map turn light blue. 

7. Click and drag the CDU icon to the desired position on the background map. 

8. Click the Save button  or the Cancel button . If saved, the CDU icon appears in its new position on the map, 
and any other icons on the map change back to their previous colors. If canceled, the map layout will not be changed.  

To Move an Icon 
1. Select the menu option Views.  

2. Select the desired map from the drop-down list. 

3. Click the Edit/Move button . All icons on the map turn light blue. 

4. Click and drag the (location, cabinet, or CDU) icon to the desired new location on the map. 

5. Click the Save button  or the Cancel button . If saved, the moved icon appears in its new 
 location and icons on the map change back to their previous colors. If canceled, the map layout is  not changed.  

To Delete an Icon 
1. Select the menu option Views.  

2. Select the desired map from the drop-down list. 

3. Click the Edit/Move button . All icons on the map turn light blue. 

4. Click and drag the icon to the desired new location on the map. 

5. Click the Save button  or the Cancel button . If saved, the moved icon appears in its new 
location and icons on the map change back to their previous colors. If canceled, the map layout is not changed.  
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Managing and Controlling Networked CDUs   

The CDU menu options provide access to the Sentry Power Manager functions for managing and controlling CDU status: 

CDU Menu Options  
Option  Description 

Manage  Provides the details about CDUs represented in the Status box in Critical, Warning,  Unreachable, 
 Normal, and Maintenance status categories; allows management of  the device status categories; and 
 gives access to the Sentry firmware interface to  configure the parameters of specific CDUs. 

List  Displays a summary list of CDUs (by CDU name) represented in the Status box in Critical, Warning, 
 Unreachable, Normal, and Maintenance status; allows  management of the device status categories; 
 and gives access to the Sentry firmware interface to configure the parameters of specific CDUs. 

Outlets  Displays the details about individual outlets in networked CDUs and allows outlet  control with On, Off, 
 and Reboot commands. 

Environmental Monitors Shows the temperature/humidity status and current thresholds of networked environmental monitors 
 (for view only). 

Clusters  Provides a list of outlet names within a specific outlet group (or outlet cluster) and  links to individual 
 outlet details (for view only), outlet action commands, and  Sentry firmware access. 

 

The CDU Manage Page  
The CDU > Manage page lets you gain visibility into network devices by providing the details of CDUs represented in 
the Status box. CDUs in Critical, Warning, Unreachable, Normal, and Maintenance status categories are displayed.  

 
This page allows management of the device status categories and gives access to the Sentry firmware interface to 
configure specific CDUs. 

Each blue bar on the CDU > Manage page represents one of the five status categories that contain reported CDUs 
requiring your attention and management. The number of CDUs in a category is shown to the far right on the blue bar, for 
example “6 device(s)”.This number is the same as reported in the Status box in the left pane. 

If a status category contains at least one CDU, expand (or collapse) the blue bar by clicking anywhere on the bar.  
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Column Descriptions 
The CDU > Manage columns are described as follows: 

• Date/Time: Date and time the CDU was reported in the category. 

• Name: Name of the CDU (user-configured).  

• IP Address: IP address of the CDU.  

• Reason: The first reported reason causing the CDU status.  

 The More… link lists all reasons for the status in a popup box: 

   
• Location (Cabinet): Name of the background image, such as “California”, followed by the cabinet name in 

parenthesis, such as “(RJF002)”. Location (Cabinet) is user-configured. 

• NIC Serial No. The Network Interface Card (NIC) serial number of the CDU. 

Changing the Sort Order 
The CDU > Manage page default sort order is ascending by IP address. To choose a different ascending sort order, open 
the category status row, and click a heading name, such as the “Location (Cabinet)” heading. The lines within the category 
are resorted. Only open category status rows containing more than one line can be sorted. Multiple open rows can be 
sorted at one time.  

Managing CDUs in Maintenance 
The CDU > Manage page allows control of CDUs in and out of Maintenance. 

 
To move CDUs to Maintenance: 

1. Check the Select checkbox to the right of one or more CDUs. 

2. Select the time period drop the drop-down list for the CDU to remain in Maintenance. 

3. Click Set/Remove Maintenance Mode. The CDU is moved to Maintenance. 

NOTE: The CDU remains in Maintenance for the time duration specified and then returns to its previous status category. Manually override the 
time duration by selecting the “Remove” option.  

 

Sentry Power Manager Using Sentry Power Manager • 25 
Operations Manual 



 
To remove CDUs from Maintenance: 

1. Check the Select checkbox to the right of one or more CDUs in Maintenance. 

2. Select the Remove option from the drop-down list. 

3. Click Set/Remove Maintenance Mode. 

Displaying a CDU Summary List 
The CDU > List page displays a summary of CDUs represented in the Status box in Critical, Warning, Unreachable, 
Normal, and Maintenance status. 

 
The CDU > List page allows quick management of CDU status, provides outlet control commands,  and gives you access 
to the Sentry firmware interface for configuring CDU parameters outside of SPM. 

Managing CDUs in Maintenance 
The CDU > List page allows control of CDUs in and out of Maintenance. 

To move CDUs to Maintenance: 

1. Check the Select checkbox to the right of one or more CDUs. 

2. Select the time period drop the drop-down list for the CDU to remain in Maintenance. 

3. Click Set/Remove Maintenance Mode. The CDU is moved to Maintenance. 

NOTE: The CDU remains in Maintenance for the time duration specified and then returns to its previous status category. Manually override the 
time duration by selecting the “Remove” option.  

To remove CDUs from Maintenance: 

1. Check the Select checkbox to the right of one or more CDUs in Maintenance. 

2. Select the Remove option from the drop-down list. 

3. Click Set/Remove Maintenance Mode. 
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Controlling Outlets with SPM: 

The CDU > List page allows the issuing of On, Off, and Reboot commands for specific outlets from within the Sentry 
Power Manager interface. 

1. Select the menu option CDU > List. 

2. Click a CDU name under the Name field. The CDU > Outlets page displays for the current CDU.  

3. For a single outlet (or multiple outlets), select a command from the Control Action drop-down list. 

4. Click Apply.  

NOTE: The level of your user access rights determines the available outlet commands. 

Accessing the Sentry Firmware: 
The CDU > List page allows direct access to the Sentry CDU firmware interface. 

NOTE: You must know the local user account login to directly access the Sentry CDU firmware interface. 

1. Select the menu option CDU > List. 

2. Click a CDU IP address under the IP address field. The Login page for the Sentry firmware displays. 

3. Login using your local user account. 

4. Use the Sentry firmware interface to configure CDU parameters. For more information, refer to the Installation 
and Operations manual for the CDU product located at www.servertech.com/support. 
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Managing and Controlling Outlets 

The CDU > Outlets page displays the details about individual outlets in networked CDUs and allows outlet control with 
On, Off, and Reboot commands. 

 
The CDUs > Outlets page displays the latest readings for outlet status, load, voltage, power, and control state, and lets you 
monitor and control power to individual (or all) outlets displayed for the CDU named at the top of the page.  

Outlets are sorted on the page by outlet name under the infeed and enclosure names of the CDU. You can control each of 
the outlets on a Switched CDU individually by issuing the On, Off, and Reboot control actions. 

Issuing Outlet Commands 
The CDUs > Outlets page provides the Control Action drop-down for issuing the On, Off, and Reboot commands to 
individual outlets or all outlets (based on user access rights for outlet control).  

To issue a command to a single outlet (or multiple outlets): 

1. Select a command from the Control Action list for each outlet you want to command. 

2. Click Apply. 

To issue a global command to all outlets: 

1. Select a command from the “Set All Outlets To” drop-down list at the bottom of the page. 

2. Click Apply. 

To view the outlets in a different CDU: 

Select a different CDU name from the drop-down list at the top of the page. 
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Viewing Outlet Details 

From the CDUs > Outlets page, click an outlet in the Outlet Name field to display outlet details:  

 
This view-only page shows detailed data for individual outlets including voltage, Kilowatt power, apparent power, crest 
factor, and power factor. 

To return to the CDUs > Outlets page, click Return. 
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Using Environmental Monitors  

The CDU > Environmental Monitors display-only page shows reported temperature, humidity, and sensor data about 
environmental monitors and sensors associated with a specific CDU. 

 
The name of the environmental monitor and related sensor names display on the page in a list sorted by sensor name under 
monitor name. Current values for the sensor status, temperature, and relative humidity are reported from the devices.  

To monitor the values of another environmental monitor, select a different CDU from the drop-down list in the upper left 
corner of the page. 
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Creating SPM Clusters  

The CDUs > Clusters page is a list of outlet names the administrator has already associated with a specific group or 
cluster.  

  
The page displays individual outlet details and lets you issue On, Off, and Reboot commands on all outlets in a group or 
cluster. Outlets can be clustered across multiple discovered CDUs. 

An outlet group is a collection of outlets on a CDU system (up to two linked enclosures) with a single IP address.  

An outlet cluster is a collection of outlets across multiple CDU systems with multiple IP addresses.  

In the example above, name in the drop-down list may be a group or cluster, depending on whether the administrator 
configures a single IP address (group) or configures multiple IP addresses (cluster). 

Groups and clusters can be configured by: 

•  Creating new outlet groups and clusters at Config > Clusters.   

•  Adding a group or cluster to a location (where the group or cluster will display on the Views page location image). 

•  Adding CDUs and power outlets to the group or cluster. 

Controlling Clusters 
To display a different cluster, select the cluster name from the drop-down list. 

To display operational details and current status for an outlet, click the outlet name. 

To connect to the CDU and login to the Sentry firmware interface, click the system IP. Username/password for the HTML 
interface is required. 

To control a specific outlet, click the system name. The Enclosure Name page displays with operational details about 
individual outlets in networked CDUs and allows outlet control with On, Off, and Reboot commands. 
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Generating SPM Reports and Logs  

The Reports menu provides several options for generating a variety of customized and detailed data reports and system 
activity logs. Reported data originates directly from the power readings of discovered CDUs in the network.  

For networks with Sentry Per Outlet Power Sensing (POPS) units, reports are available to show energy value readings for 
consumption and usage based on individual outlets, devices, groups/clusters, or the entire data center. For more 
information about the POPS feature, see www.servertech.com

Reports formats are HTML, XML, Microsoft Word, or Microsoft Excel. You can view reports and logs online or in print. 

The following options are available on the Reports menu: 

Reports Menu Options  
Option  Description 

Energy Consumption For the administrator. Generates total energy consumption reports for outlet and  infeed billing levels; 
 reports are available by location, cabinet, CDU, and outlet group/cluster. 

Energy Utilization    For the administrator. Generates Power Outlet Power Sensing (POPS) reports from energy value  
   readings to measure and evaluate CDU and group/cluster outlet energy usage and efficiency. 

General Reports    Produces several CDU hardware-based reports for inventory, voltage, power, and environment;   
   generates reports by location, cabinet, and combined location/cabinet. 

Trends    Generates a graphic trend report on specific variables from current CDU readings over a specified   
   time frame as applicable data is available to be reported. rend report choices are temperature,   
   humidity, infeed load, infeed power, system watts/unit area, and system total power. 

Logs    Branches to options for detailed system activity logs: Discovery, User Login, Use Actions, Alarm   
   Status, and Combined (combines all system activity into one report). The logs (with the exception of  
   Combined) can be used for Email alert. 

NOTE: To print a report or log, right-click on the displayed report or log and select Print or select File > Print from your browser window. 
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Reporting Energy Consumption 

For the administrator: The Reports > Energy Consumption option generates total energy consumption reports for outlet 
and infeed billing levels. You can generate a total energy billing report by day, month, or year based on infeed or outlet 
data for the reporting period. Reports are available by location, cabinet, CDU, and outlet group/cluster.  

 

Energy Consumption Report Options  
Report Parameter You select… 

Report Type  Day, month, or year. 

Billing Level  Outlet or infeed. 

Reported On  For outlet: location, cabinet, CDU, or group/cluster. A detailed CDU or group/cluster report shows outlet 
 name. For infeed: location, cabinet, or CDU. A detailed CDU report shows infeed name. 

Location  Specific location name(s) or all locations. 

Start Date/End Date Desired date range. Default is last week, showing End Date as today’s date. 

Format  HTML, XML, Microsoft Word, or Microsoft Excel. 

 

. 
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Examples of Energy Consumption Reports 

The following examples show a few of the available energy consumption reports: 

Outlet Billing Level – By Location: 

 

Outlet Billing Level – By CDU: 

 

Outlet Billing Level – By CDU Detailed: 

 
NOTE: The CDU detailed report includes outlet name. 
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Reporting Energy Utilization 

For the administrator: For networks with Sentry Per Outlet Power Sensing (POPS) units, the Reports > Energy 
Utilization generates several reports from energy value readings to measure and evaluate CDU and group/cluster outlet 
energy usage and efficiency. 

 

Energy Utilization Report Options  
Report Parameter You select… 

Type  No usage, low usage, or high usage. 

Subtype  Zero for all readings. Subtype is a fixed parameter. 

Reported On  CDU or cluster/group. 

Location  Specific location name(s) or all locations. 

Start Date/End Date Desired date range. Default is last week, showing End Date as today’s date. 

Format  HTML, XML, Microsoft Word, or Microsoft Excel. 
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Example of Energy Utilization Reports 
The following example shows an available energy utilization report: 

No Usage – Reported on CDU – All Low Readings 

 
 

Low Usage – Reported on CDU – At Least One Low Reading 
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Viewing General SPM Reports  

The Reports > General Reports option produces several report types for inventory, input voltage, input power, power 
density, and environment. 

 

General Report Options  
Report Parameter You select… 

Type  Inventory, Input Voltage, Input Power, Total Power, Power Density, Environment. 

Location  Specific location name(s) or all locations. 

Group By  Location, cabinet, location/cabinet, or no grouping. 

Format  HTML, XML, Microsoft Word, or Microsoft Excel. 
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Example of General Reports 
The following examples show some of the general reports available for SPM: 

Inventory – By Location/Cabinet 

 
 

Environment – By Location:  
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Total Power – By Cabinet 

 
 
Input Voltage – No Grouping 
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Generating Graphical Trend Reports 
The Reports > Trends option uses data collected from current CDU readings and converts the data into graphic charts 
based on the requested time frame. A trend report can be generated for several parameters during a specified time period, 
however, only available data from CDU readings for the designated parameter and time frame you select will be reported.   

 
The example above shows that Trend reports can be generated over a specified time range for historic reporting of 
variations in temperature, humidity, outlet (load/power), infeed (load/power), system watts/unit area, and system total 
power.  

Running a Trend Report 

  
The Trends page opens with a system-generated default date range for the last seven days with Ending Date as the current 
date. To change the default date range, roll over the date boxes for a popup calendar, shown above. 
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Depending on the type of Trend report you choose (for example, humidity), only the networked devices with measured 
readings from the CDU for humidity will be collected and displayed in the  parameters list box, as shown in the following 
example. The outcome of the trend report is based on your selection of these parameters. 

 
Select up to 12 CDU-related parameters from the list as follows:  

•    To select a block of adjacent parameters, click the first item in the block, press and hold down the Ctrl + Shift keys, 
and click the last item in the block.  

• To select non-adjacent parameters, click the first item, press and hold down the Ctrl + Alt keys, and click each 
additional item.  

To run the trend report for the parameters you selected, click View Trends. The report displays in a graphic format, 
similar to the following sample: 

 
To print the trend report, right-click on the displayed trend report and select Print Chart, or select 
File > Print from your browser window. 

NOTE: The longer the time frame requested for the trend report, the less detail will be available for reporting. In addition, some parameters you 
select for the trend report may not have available data measured by the CDU for the specified time frame; therefore, those parameters will not be 
displayed on the trend report.  
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Viewing System Activity Logs  

The Reports > Logs option provides access to specific system activity logs such as alarm status, results of CDU 
discovery, user actions when using SPM, user login/logout activity, and all SPM system activity combined into a single 
report. 

Discovery  
The Discovery log lists the events that occur during the discovery of individual CDUs and ranges of CDUs in the network. 
The most current discovery activity displays first. 

 
The Discovery log shows IP address, discovery event time, and a detailed description of the discovery event, such as 
“Discovery process completed for IP 10.1.2.137 though IP 10.1.2.137”.  

Working with the Discovery Log 

The Discovery Log opens with a system-generated default date range for the last seven days − Ending Date is current date. 
To change the default date range, roll over the date boxes for a popup calendar, shown above. 

• To filter the log by a specified date range, select the Starting and Ending dates, and click Filter. 

• To sort the log data by a column heading, click the desired column heading (arranges data in ascending order by 
heading), or click again (arranges data in descending order by heading).  

• The Discovery Log is available for delivery by Email alert. See Configuring Email Alerts on page 74.  

• To print a report or log, right-click on the displayed report or log and select Print or select File > Print from your 
browser window. 

Clearing the Log  

For the administrator: To delete log data permanently, click Clear Log. You are prompted to confirm the deletion. 
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Viewing User Login Activity 

The Reports > User Login option shows all login attempts to SPM. The log is generated by the date range specified, and 
the most current activity displays first. 

 
The User Login displays the user name, IP address of the CDU affected by login, time of login attempt, and a detailed 
description of the login.  

Working with the User Login Log 

The User Login Log opens with a system-generated default date range for the last seven days − Ending Date is current 
date. To change the default date range, roll over the date boxes for a popup calendar, shown above. 

• To filter the log by a specified date range, select the Starting and Ending dates, and click Filter. 

• To sort the log data by a column heading, click the desired column heading (arranges data in ascending order by 
heading), or click again (arranges data in descending order by heading).  

• The User Login is available for delivery by Email alert. See Configuring Email Alerts on page 74.  

Clearing the Log  

• For the administrator: To delete log data permanently, click Clear Log. You are prompted to confirm the deletion. 
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Reviewing User Actions 

The Reports > User Actions log displays system activity details by specific username. The most current activity displays 
first, displaying an account of chronological system activity. 

 
The User Actions log shows user name, IP address of the affected CDU, time of system activity, and a detailed description 
of the activity.  

Working with the User Actions Log 

The User Actions Log opens with a system-generated default date range for the last seven days − Ending Date is current 
date. To change the default date range, roll over the date boxes for a popup calendar, shown above. 

• To filter the log by a specified date range, select the Starting and Ending dates, and click Filter. 

• To sort the log data by a column heading, click the desired column heading (arranges data in ascending order by 
heading), or click again (arranges data in descending order by heading).  

• The User Actions log is available for delivery by Email alert. See Configuring Email Alerts on page 74.  

Clearing the Log  

• For the administrator: To delete log data permanently, click Clear Log. You are prompted to confirm the deletion. 
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Receiving Alarm Status Notification 

The Reports > Alarm Status log provides system polling details of CDU status changes within in the predetermined 
status categories: Critical, Warning, Unreachable, Normal, and Maintenance. The most current activity displays first. 

 
The Alarm Status log shows the IP address of the CDU, status event time, and a detailed description of the status change.  

Working with the Alarm Status Log 

The Alarm Status Log opens with a system-generated default date range for the last seven days − Ending Date is current 
date. To change the default date range, roll over the date boxes for a popup calendar, shown above. 

• To filter the log by a specified date range, select the Starting and Ending dates, and click Filter. 

• To sort the log data by a column heading, click the desired column heading (arranges data in ascending order by 
heading), or click again (arranges data in descending order by heading).  

• The Alarm Status log is available for delivery by Email alert. See Configuring Email Alerts on page 74.  

Clearing the Log  

• For the administrator: To delete log data permanently, click Clear Log. You are prompted to confirm the deletion. 
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Viewing the Combined Activities Log 

The Reports > Combined log displays all system activities in Sentry Power Manger as reported by the 
individual logs (Discovery, User Login, User Actions, and Alarm Status) in one combined report. 

 
The Combined log shows User Name, IP address of the affected CDU, the time of the recorded system event, and a 
detailed description of the event. The most current activity displays first. 

Working with the Combined Log 

The Combined Log opens with a system-generated default date range for the last seven days − Ending Date is current date. 
To change the default date range, roll over the date boxes for a popup calendar, shown above.  

• To filter the log by a specified date range, select the Starting and Ending dates, and click Filter. 

• To sort the log data by a column heading, click the desired column heading (arranges data in ascending order by 
heading), or click again (arranges data in descending order by heading).  

NOTE: The Combined Log is not available for Email alert.  

Clearing the Log  

• For the administrator: To delete log data permanently, click Clear Log. You are prompted to confirm the deletion. 
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Configuring Sentry Power Manager 

The Configuration menu provides the options necessary for setting up and configuring SPM. The settings you configure in 
SPM specifically for the CDU, such as names for enclosures, infeeds, and outlets, as well as infeed/outlet load thresholds, 
are pushed down from SPM directly to the CDU.  

The following options are available on the Configuration menu: 

Configuration Menu Options  
Option  Description 

Locations  Configures and manages default maps and custom images used as the background (on  the Views page) 
 where the icons for locations, cabinets, and CDUs are placed. 

Cabinets  Adds, edits, and deletes cabinets; specifies cabinet area (in square ft.) for calculation of  system wattage; 
 associates a cabinet with a location. 

CDUs  Branches to options for specific CDU administrative tasks: CDU discovery, configuration  of CDU parameters, 
 and the editing of environmental monitors, sensors, thresholds, enclosures, and outlets; associates a CDU 
 with a cabinet/location. 

Clusters  Structures the data center by allowing you to configure a collection of CDU power outlets into named 
 “groups” or “clusters”. If SPM discovers a CDU, then the outlets in the CDU are available to be collected into 
 groups or clusters for faster administration. The  Clusters option also allows you to grant access rights to the 
 group or cluster for locations, CDUs, and outlets. 

Users  Allows administration of individual user names and passwords, associates user with 
 a specific user group, and determines user access rights by user type.   

User Groups  Allows administration of user groups and their association with user types, grants permission to user groups 
 for locations, clusters, cabinets, CDUs, and outlets.  

LDAP  Configures the detailed parameters for Lightweight Directory Access Protocol (LDAP). 

Group Permissions Grants user group permissions by clusters, locations, cabinets, CDUs, and outlets.  

Email  Configures email alerts for specified system activity logs (Discovery Status, User Logins, User Actions, and 
 Alarm Status) to a primary and secondary email address. 

Access  Allows configuration of SPM network access parameters for system, network 
 ports, web, Telnet, serial ports, and database. 

NOTE: The administrator login has full access to all default and custom images and icons. The administrator must grant each user account access 
to individual background images and icons with the Config > Users function. 

About User Types 
User types are the levels of access rights to SPM as granted by the administrator to users and user groups. The following 
user types are recognized by SPM: 

User Types 
Type Description 

Admin Administrative. Full access for all configuration, control (On, Off, Reboot), status, and serial/pass-thru ports. At 
SPM installation, the default administrative user is the admn user account. (Note there is no “i” in the admn user 
account name/password.) The admn user may grant full administrative access level rights to other users. See 
Note below. 

Regular User Partial access for control (On, Off, Reboot), status, and pass-thru of assigned outlets, groups, clusters, and 
serial/pass-thru ports. 

View Only Partial access for status and pass-thru of assigned outlets, groups, clusters, and serial/pass-thru ports. 

Reboot Only Partial access for control (Reboot), status, and pass-thru of assigned outlets, groups, clusters, and serial/pass-thru 
ports. 

NOTE: For security, it is recommended that you first use the default admn user account to grant access rights to another administrative user 
account. Then using the new administrative account, change (or delete) the default admn user account. The default admn account cannot be 
demoted or deleted until you have already granted administrative access rights to another user account. 
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Establishing Location Images  

The Config > Locations page allows the administrator to configure and manage default maps and custom images which 
are then displayed on the Views page as backgrounds for device icons. 

 
Location images include the default world maps and USA state maps (as shown above) that are installed with SPM. In 
addition, backgrounds can include any custom images the administrator uploads to SPM after installation.  

Acceptable graphic file formats are JPG, PNG, or GIF. The maximum graphics file size must be less than 800 pixels wide. 
The screen resolution determines the height of the displayed graphic. 

Any default or custom image can be accessed by the administrator to provide the working background pictures displayed 
on the Views page where icons are placed to represent actual data center locations, cabinets, and CDUs.  

The levels of the data center in location images can range from global maps to detailed images, depending on how the 
administrator decides to represent the data center. Later, icons representing actual data center locations, cabinets, and 
CDUs are positioned on the location images. 

Capacity Fields 
Fields Description 
Actual Capacity User-defined value to show the maximum capacity of the sum of the infeed circuits; for example, 2 x  
 L630P – 208V * 30A*2= 12,480W. 
 

Theoretical Capacity User-defined value to show the desired “safety rating” of the sum of the infeed circuits, 20% in this   
    example: 2 x L630P – 208V*30A*2*.8= 9,984W.    

Adding a New Location Image 
1. Select the menu option Config > Locations. 

2. Type a Name for the image (required). 

3. (Optional). Type a numeric value in the Actual Capacity field. 

4. (Optional). Type a numeric value in the Theoretical Capacity field. 

5. Click Browse to locate the desired image; once selected the Filename field populates with the pathname of the 
image.  

6. Click Add. The message “Location Image Uploaded” displays and the new image is added by name to the drop-
down location list on the Views page. The image is also added to the Config > Locations page and shows a 
checkmark in the Use checkbox. 
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Disabling a Location Image 

1. Select the menu option Config > Locations. 

2. Uncheck the Use checkbox next to the image name you want to disable and click Apply Changes. The disabled 
image remains in SPM (to be enabled later, if desired) but the image does not appear in the drop-down list on the 
Views Page. 

Enabling a Location Image 
1. Select the menu option Config > Locations. 

2. Check the Use checkbox next to the image name you want to enable, and click Apply Changes. The enabled 
image appears in the drop-down list on the Views Page.  

Editing a Location Image Name 
1. Select the menu option Config > Locations. 

2. Type over the name of an image in the Name field and click Apply Changes. The edited image name appears in 
the drop-down list on the Views Page.  

Viewing a Location Image Thumbnail 
1. Select the menu option Config > Locations. 

2. Roll over the square button  to the right of an image name to view a thumbnail of the image.  

Deleting a Location Image 
1. Select the menu option Config > Locations. 

2. Check the Delete checkbox to the far right of the image name you want to delete and click Apply Changes. The 
image is permanently removed from SPM. 

NOTE: Only empty background images can be deleted. If a background image contains at least one location, cabinet, or CDU, the Delete 
checkbox is not available.  

Changing a Location Image 
1. Select the menu option Config > Locations. 

2. Click the Browse button (under the Image heading) to the right of the location name you want to change.  

3. Select a new image. The new file pathname appears in the Image field. 

4. Type over the name shown in the Name field (if you want to change the name). 

5. Select the desired location for the new image from the Location drop-down list. 

NOTE: Changing a location image is a delete-add shortcut that allows an image simply to be replaced with another image. 
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Configuring Data Center Cabinets 

The Config > Cabinets page allows the administrator to configure and manage cabinets. 

 
The Config > Cabinets page allows the adding, editing, and deleting of cabinets. In addition, cabinets can be associated 
with locations. When a cabinet is added and associated with a location, the cabinet icon appears on the Views page.  

The area of the cabinet (for the calculation of total system watts) and capacity planning data for the cabinet (actual 
capacity and theoretical capacity) can be configured. 

Capacity Fields 
Fields Description 
Actual Capacity User-defined value to show the maximum capacity of the sum of the infeed circuits; for example, 2 x 
 L630P – 208V * 30A*2= 12,480W. 
 

Theoretical Capacity User-defined value to show the desired “safety rating” of the sum of the infeed circuits, 20% in this   
    example: 2 x L630P – 208V*30A*2*.8= 9,984W.    
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Adding a New Cabinet 
1. Select the menu option Config > Cabinets. 

2. In the Name field, type a name for the new cabinet. (Required).  

3. In the Area field, type a numeric value (in square ft.). Use whole numbers only – no fractions.  

4. (Optional). Type a numeric value in the Actual Capacity field. 

5. (Optional). Type a numeric value in the Theoretical Capacity field. 

6. From the Location drop-down list, select a location where the cabinet will be placed.  

7. Click Add. The new cabinet is added to the list on the Cabinets page and also displays on the Views page under 
the location specified (unless you selected “None” for the location). 

NOTE: The “None” Location disassociates a cabinet from all location images but keeps the cabinet available in SPM. 

Editing a Cabinet  
1. Select the menu option Config > Cabinets. 

2. In the list of cabinets, for one or more cabinets, type over the Name, Area, Actual Capacity, Theoretical 
Capacity, and Location as you want to update these fields. The Area field is sq. ft. and must be a whole number. 

3. Click Apply Changes. The edits to the cabinet(s) are applied throughout SPM.  

Deleting a Cabinet  
1. Select the menu option Config > Cabinets. 

2. In the list of cabinets, for a single cabinet (or multiple cabinets), check the Delete checkbox.  

3. Click Apply Changes. A confirmation message displays. If confirmed, the cabinet is removed from SPM. 

NOTE: Only empty cabinets can be deleted. If a cabinet contains one or more CDUs, the Delete checkbox is not available.  
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Managing CDUs 

The Config > CDUs option branches to additional options for CDU administrative tasks: discovery of CDUs, adding and 
configuring CDUs, and configuring environmental monitors, sensors, enclosures, and outlets. 

Discover CDUs 
The Discover CDUs option allows the administrator to define parameters for CDU manual discovery as SPM searches 
multiple subnets for SNMP-enabled CDUs. This option also allows editing of CDU name, SNMP GET/SET community 
string, and CDU capacity.  

 
Use the Discovery feature for the initial discovery of CDUs when SPM is installed, and then to discover new CDUs as 
they are installed in the network. Discovered CDUs communicate with SPM to report alarms and CDU status changes to 
assist in global management of your network.  

About the FTP Fields 

SPM uses the FTP configuration of the CDU to obtain CDU group information for discovery. Therefore, the FTP User 
Name and FTP Password fields (the valid administrative user name and password used for direct access of the CDU 
through the Sentry interface), are required on the Setup a Discovery page as shown in the example above.  

List of Discovered CDUs 

Discovered CDUs appear in a list at the bottom of the Discovery page in alphabetic order by CDU name (default is  IP 
address).  

The Discovery feature has the capability to discover a CDU with its single IP address or to discover multiple CDUs in a 
range of IP addresses.  

NOTE: The Discovery function is executed immediately upon request and cannot be scheduled. 
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Discovery Process Setup 

To discover a single CDU: 

1. Select the menu option Config > CDUs > Discover CDUs. 

2. Type the Discovery Starting IP Address in the box provided. Be sure to type IP address, not a hostname. 

3. In the Discovery End Subnet Value box, type the last node of the starting IP address. For example, if the starting 
IP address typed is 10.1.1.74, then type “74” in the Discovery End Subnet Value box. The Discovery feature will 
search, discover, and connect only the one CDU specifically named 10.1.1.74. 

4. Type the SNMP community string from the SNMP settings on the CDU in the network. The community string is 
used during the discovery process. 

5. In the FTP User Name and FTP Password fields, type the valid administrative user name and password used for 
direct access of the CDU through the Sentry product’s firmware interface. Note that the FTP fields may not be 
the same as your administrative user name and password for login to SPM. 

6. Click Initiate CDU Discovery to perform an immediate discovery on the single CDU.  

To discover multiple CDUs: 

1. Select the menu option Config > CDUs > Discover CDUs. 

2. Type the Discovery Starting IP Address in the box provided. Be sure to type IP address, not a hostname. 

3. In the Discovery End Subnet Value box, type the IP address of the last CDU you want discovered. For example, 
if the starting IP address typed is 10.1.1.74, and the Discovery End Subnet Value is 10.1.1.125, then the 
Discovery feature will search, discover, and connect all CDU names in the range between the IP addresses 
10.1.1.74 and 10.1.125. 

4. Type the SNMP community string from the SNMP settings on the CDU in the network. The community string is 
used during the discovery process.  

5. In the FTP User Name and FTP Password fields, type the valid administrative user name and password you use 
for direct access of the CDU through the Sentry product’s firmware interface. Note that the FTP fields may not 
be the same as your administrative user name and password for login to SPM. 

6. Click Initiate CDU Discovery to perform an immediate discovery on the range of CDUs specified.  
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Add CDU 

The Config > CDUs > Add CDU option directs SPM to discover one CDU at a time by  
the exact IP address of the CDU. 

 
Use the Add New CDU page for convenience to discover a single CDU in the SPM network by entering the IP address of 
the CDU, such as 10.1.1.74 shown in the example above. 

This page works the same way in the discovery process as the Config > CDUs > Discover CDUs page, but only discovers 
one IP address at a time. The Add New CDU page can be a quick and convenient way (after bulk discovery of CDUs by IP 
address range) to add and discover a single CDU or a few CDUs by exact IP address. 

About the FTP fields: 

SPM uses the FTP configuration of the CDU to obtain CDU group information for discovery. Therefore, the FTP User 
Name and FTP Password fields (the valid administrative user name and password used for direct access of the CDU 
through the Sentry interface), are required on the Setup a Discovery page as shown in the example above.  

To add a single CDU: 

1. Type the exact IP address of the new CDU. 

2. Provide the SNMP community string from the SNMP settings on the CDU in the network. The community string 
is used during the discovery process.  

3. Type the FTP User Name/Password. 

4. Click Add CDU. 
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Configuring CDUs 

The Config > CDUs > Configure CDUs option allows the administrator to edit the detailed parameters of discovered 
CDUs in the network. 

 
The Configure CDUs page lists the current settings of discovered CDUs and shows the associated cabinet and location. All 
configured settings on this page are pushed directly down to the CDU. This page allows CDUs to be deleted. 

Configure CDU parameters: 

1. Edit values or select values from the drop-down list for a single CDU (or multiple CDUs). 

2. Click Apply Changes. 

NOTE: The CDU capacity is measured by a numeric watts value. 

Delete a  CDU: 

1. Check the Delete checkbox for a single CDU (or multiple CDUs) to be deleted. 

2. Click Apply Changes. 
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Setting Environmental Monitors 

The Config > CDUs > Environmental Monitors option lets the administrator edit the names of environmental monitors 
and sensors, and set the sensor high/low thresholds for temperature/humidity. 

  
High/low sensor temperature thresholds are measured in degrees Celsius; high/low sensor humidity thresholds are 
measured in percentage. 

Configure Environmental Monitor Name, Sensor Name, or Sensor Values: 

1. Select a CDU from the drop-down list. 

2. Edit the environmental monitor name, sensor name, temperature value, and humidity value as necessary. 

3. Click Apply Changes. 
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Editing Enclosures, Infeeds, and Outlets  

The Config > CDUs > Enclosures option allows the administrator to edit the names of the individual components of a 
CDU: enclosures, infeeds, and outlets. The option also allows configuration of load threshold (in amperes) and low/high 
power limit (in watts). 

 
An enclosure is a Sentry unit (made up of infeeds and outlets) that is part of an overall Sentry CDU. In the example above, 
the Sentry Switched CDU 66.214.208.93 is made up of the following units: 

•  A Switched master unit named TowerA. The TowerA unit is the first enclosure with an infeed named 
TowerA_InfeedA.  TowerA_InfeedA has several related outlets, starting with TowerA_InfeedA_Outlet1 and so on. 

• A Switched extension unit named TowerB. TowerB is the second enclosure with an infeed named TowerB_InfeedA. 
TowerB_InfeedA has several related outlets, starting with TowerA_InfeedB_Outlet1 and so on. 

Both the master and extension units are considered two separate enclosures in the single Sentry CDU named 
66.214.208.93. 

To configure enclosure settings: 

1. Select a CDU from the drop-down list. 

2. Edit the names for enclosure, infeed, and outlet, and type over the numeric value for enclosure power load (in 
amperes), as necessary. 

3. Click Apply.  
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Arranging Outlet Groups and Clusters 

The Config > Clusters option allows the administrator to structure the data center by configuring collections of CDU 
power outlets into named groups or clusters. As long as SPM has discovered a CDU in the network, outlets can be 
gathered into groups or clusters. 

  
An outlet group is a collection of outlets on a CDU system (up to two linked enclosures) with a single IP address.  

An outlet cluster is a collection of outlets across multiple CDU systems with multiple IP addresses.  

In the example above, the Type field displays “Group” or “Cluster”, depending on whether the administrator configures a 
single IP address (group) or configures multiple IP addresses (cluster). 

Groups and clusters can be configured by: 

•  Creating new outlet groups and clusters.   

•  Adding a group or cluster to a location (where the group or cluster will display on the Views page background 
image). 

•  Adding CDUs and power outlets to the group or cluster. 

NOTE: The Type field is determined by the outlet configuration of the CDU, either “Group” or “Cluster” depending on the configuration of 
physical outlets in the CDU – either a single IP address (Group), or multiple IP addresses (Cluster). 

Add a Group or Cluster 
1. Select the menu option Config > Clusters. 

2. In the Add New Cluster box, type the new outlet group name or cluster name. 

3. Click the Add button. 

A successful add message displays and the new group or cluster name appears on the list in the Name column. 

NOTE: When a new group or cluster is added, by default the Type name displays “Group”. For the Type name to change to “Cluster”, you must 
assign outlets across multiple CDU systems (multiple linked enclosures) with multiple IP addresses.  
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Edit a Group or Cluster 

1. Type over the names for the group/cluster. 

2. Click Apply Changes. 

Delete a Group or Cluster 
1. Check the Delete checkbox for a single CDU or multiple CDUs to be deleted. 

2. Click Apply Changes. 

Add a Location to a Group or Cluster 
1. From the Add New Cluster page, click the Locations link for the desired group/cluster. The Locations window 

displays: 

                
2. Check the location checkboxes to add the group or cluster named at the top of the window to the locations(s) 

shown. To remove the group or cluster from the location, uncheck the checkboxes. 

3. Click Apply Changes. 

4. To return to the Add New Cluster page, click Return.  

Add a CDU to a Group or Cluster 
1. From the Add New Cluster page, click the CDUs link for the desired group/cluster. The CDUS window displays: 

                
2. Check the CDU checkboxes to add the group or cluster to the CDU(s) shown. To remove the group or cluster 

from the CDU, uncheck the checkboxes. 

3. Click Apply Changes. 

4. To return to the Add New Cluster page, click Return. 
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Add an Outlet to a Group or Cluster 

1. From the Add New Cluster page, click the Outlets link for the desired group/cluster. The Outlets window 
displays: 

                
2. Check the Outlet checkboxes to add the group or cluster to the outlet(s) shown. To remove the group or cluster 

from the outlets, uncheck the checkboxes. 

3. Click Apply Changes. 

4. To return to the Add New Cluster page, click Return. 
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Configuring SPM Users  

The Config > Users option allows the administrator to configure and maintain the parameters of SPM users. Multiple 
SPM users can be logged in concurrently. 

+ 

The Users page allows maintenance of users, user passwords, and user group assignments.    

Adding a new user: 
1. Select the menu option Config > Users. 

2. Type the new user’s name, password, password confirmation, and select a user group from the drop-down menu. 
Password is case-sensitive; strong passwords are supported by SPM but are not required. 

3. Click Add/Change. The new user name and associated user group appear on the page. 

Changing a username: 
1. Select the menu option Config > Users. 

2. Type over the user’s name in the Name field. 

3. Click Apply Changes. The user name is changed. 

Changing a user’s password: 
1. Select the menu option Config > Users. 

2. Type the user’s name, a new password, and password confirmation. Password is case-sensitive; strong passwords 
are supported by SPM but are not required. 

3. Click Add/Change. The user’s password is changed. 

Deleting a user: 
1. Select the menu option Config > Users. 

2. Check the Delete checkbox next to the user’s name you want to delete. 

3. Click Apply Changes. You are prompted to confirm the deletion. If confirmed, the user is deleted from SPM. 

Changing a user’s group: 
1. Select the menu option Config > Users. 

2. From the drop-down list next to the user’s name, select a different user group.  

3. Click Apply Changes. The user group association is changed. 
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About User Group Security 

SPM has a user and user group system that provides access to internal components such as CDUs, locations, and outlet 
groups/clusters. System security is defined at the user group level, and a user is assigned only one user group by the SPM 
administrator. 

In addition to the user group levels, the user group can have another attribute that determines direct access to the SPM 
components: This attribute determines an admin user, regular user, reboot only user, or view only user. Admin level users 
have full access; the view only user can see the devices but cannot control them.  

In addition, SPM can define LDAP user groups. If a user is a member of a specific LDAP user group, the user can be 
defined outside of SPM and be associated with the external LDAP user group. 
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Configuring SPM User Groups 

The Config > User Groups option allows the administrator to configure and maintain the parameters 
of SPM user groups and assign user group permissions for clusters, locations, cabinets, CDUs, and outlets. 

 
The User Groups page allows configuration and maintenance of user groups, user group passwords, and the assignment of 
user groups to user type categories (admin, reboot-only, regular, and view-only) This page also allows the administrator to 
assign permissions to user groups for clusters, locations, cabinets, CDUs, and outlets. 

Adding a New User Group: 
1. Select the menu option Config > User Groups. 

2. Type the new user group name and select a user type from the drop-down menu. 

3. Click Apply Changes. The new user group is added to the Config > User Groups page, and the User 
Permissions page for Locations is displayed: 

                               
4. Check the appropriate checkboxes to set locations for the new user group, and click Apply Changes.  
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5. From the drop-down list select Clusters, Cabinets, CDUs, or Outlets and check the appropriate checkboxes to 

assign access rights for the user group to  

   

Changing a User Group Name: 
1. Select the menu option Config > User Groups. 

2. Type over the user group name in the Name field. 

3. Click Apply Changes. The user group name is changed (user type and access rights to devices are not affected). 

Deleting a User Group: 
1. Check the Delete checkbox next to the user group name you want to delete. 

2. Click Apply Changes. You are prompted to confirm the deletion. If confirmed, the user group is deleted from 
SPM. 

Changing the User Type (Access Rights Level): 
1. Do one of the following: 

• From the Type drop-down list next to the user group name, select a different user type, and click Apply 
 Changes.  

• Type the user group name in the Name field (top of  page), select a different user from the Type drop-down 
 list (top of page), and click Add/Change. 
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User Types   

User types are the levels of access rights to SPM as granted by the administrator to users and user groups. The following 
user types are recognized by SPM: 

User Types 
Type Description 

Admin Administrative. Full access for all configuration, control (On, Off, Reboot), status, and serial/pass-thru ports. At 
SPM installation, the default administrative user is the admn user account. (Note there is no “i” in the admn user 
account name.) The admn user may grant full administrative access level rights to other users. See Note below. 

Regular User Partial access for control (On, Off, Reboot), status, and pass-thru of assigned outlets, groups, clusters, and 
serial/pass-thru ports. 

View Only Partial access for status and pass-thru of assigned outlets, groups, clusters, and serial/pass-thru ports. 

Reboot Only Partial access for control (Reboot), status, and pass-thru of assigned outlets, groups, clusters, and serial/pass-thru 
ports. 

NOTE: For security, it is recommended that you use the default admn user account to grant access rights to another administrative user account. 
Then using the new administrative account, change (or delete) the default admn user account. The admn account cannot be demoted or deleted 
until you have already granted administrative access rights to another user account. 
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Determining LDAP Settings 

The Config > LDAP page allows the administrator to configure the settings required to enable  
SPM’s support for Lightweight Directory Access Protocol (LDAP).  

 
The LDAP support enables authentication with LDAP servers so that user accounts do not need to be individually created 
locally on each Sentry CDU.  

SPM administrators can pre-define and configure – in each Sentry product and in the LDAP server – a set of necessary 
LDAP groups, and access rights for each group. The user’s access rights can then be granted or denied simply by making 
the user a member of one or more pre-defined Sentry LDAP Groups. User accounts can be added, deleted, or changed in 
the LDAP server without any changes needed on individual Sentry CDUs. 

Sentry CDU support for LDAP has been tested in the following environments: 

• Microsoft Active Directory (MSAD) 
• Novell eDirectory (eDir) 

Enabling or disabling LDAP support: 
Select Enabled or Disabled from the LDAP drop-down menu and click Apply.   

Setting the LDAP server address: 
Type the IP addresses (or hostnames) in the Primary and/or Secondary Host fields and click Apply. 

Changing the LDAP server port: 
Type the server port number in the Port field and press Apply. 

Enabling or disabling LDAP over TLS/SSL: 
Select Yes or No from the Use TLS/SSL drop-down menu and click Apply.  

NOTE: If LDAP over TLS/SSL is enabled, MD5 binding is disabled. 

Setting the LDAP bind type: 
Select Simple or MD5 from the Bind Type drop-down menu and click Apply.  

NOTE: If MD5 binding is enabled, LDAP over TLS/SSL is disabled. 

Setting the search bind Distinguished Name (DN): 
Type the fully-qualified distinguished name (FQDN) in the Search Bind DN field and click Apply. 
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Setting the search bind password for Distinguished Name (DN): 

Type the Search Bind Password in the Search Bind Password field and click Apply. 

Setting the user search base Distinguished Name (DN): 
Type the User Search Base DN in the User Search Base DN field and click Apply. 

Setting the user search filter: 
Type the User Search Filter in the User Search Filter field and click Apply. 

Setting the group membership attribute: 
Type the group membership attribute in the Group Membership Attribute Field and click Apply. 

Setting the group membership value type: 
Select DN or Name  from the Group Membership Attribute drop-down menu and click Apply. 

Configuring the authentication order: 
Select Remote->Local or Remote Only from the drop-down menu and click Apply. 

NOTE: Server Technology recommends NOT setting the authentication order to Remote Only until the LDAP has been fully configured and 
tested.   
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LDAP User Groups 

The User Groups link allows the administrator to configure the settings required to establish SPM users in LDAP group 
membership. From the Config > LDAP page, click the User Groups link:  

 
The LDAP User Groups page allows complete LDAP user group maintenance: new user groups added, user group names 
changed, user groups deleted, user group assignment (admin users, reboot-only users, regular users, and view-only users), 
and user group assignment changed.  

Adding a new LDAP user group: 
1. Select the menu option Config > LDAP and click the User Groups link. 

2. Type the new LDAP user group name in the Name field and select a user group association from the User Group 
drop-down menu. 

3. Click Apply Changes. The new LDAP user group is added to the Config > User Groups page under the Name 
heading and the user group association is shown under the User Group heading. 

Changing an LDAP user group name: 
1. Select the menu option Config > LDAP and click the User Groups link. 

2. Type over the LDAP user group name in the Name field. 

3. Click Apply Changes. The LDAP user group name is changed. 

Deleting an LDAP user group: 
1. Select the menu option Config > LDAP and click the User Groups link. 

2. Check the Delete checkbox next to the LDAP user group name you want to delete. 

3. Click Apply Changes. You are prompted to confirm the deletion. If confirmed, the LDAP user group is deleted 
from SPM. 

Changing an LDAP user group association: 
1. Select the menu option Config > LDAP and click the User Groups link. 

2. From the drop-down list next to the user group name, select a different user type.  

3. Click Apply Changes. The LDAP user group association is changed. 
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Setting Group Permissions  

The Config > Group Permissions option branches to other choices for viewing and editing 
specific group permissions for clusters, locations, cabinets, CDUs, and outlets. 

Clusters 
The Config > Group Permissions > Clusters page displays current cluster names and user group names for viewing and 
assigning user group permission to clusters.  

 

Assigning user group permissions to clusters: 
1. Select the menu option Config > Group Permissions > Clusters. 

2. Select Clusters from the drop-down list. 

3. To grant permissions, check the corresponding checkboxes between individual cluster names (on the left) and 
individual user group names (at the top).  

•  To deny permissions, clear the checkboxes as necessary.  

•  To view and assign permissions for a specific user group, select the user group name from 
     the pull-down list. 

4. Click Apply Changes. User group permissions for clusters are updated. 

NOTE: To assign permissions to all user groups for a single cluster or multiple clusters, check the All User Groups checkbox. 
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Setting Permissions for Locations  
The Config > Group Permissions > Locations page displays current location names and user group names for viewing 
and assigning user group permission to locations.  

 

Assigning user group permissions to locations: 
1. Select the menu option Config > Group Permissions > Locations. 

2. Select Locations from the drop-down list. 

3. To grant permissions, check the corresponding checkboxes between individual location names (on the left) and 
individual user group names (at the top).  

•  To deny permissions, clear the checkboxes as necessary.  

•  To view and assign permissions for a specific user group, select the user group name from 
     the pull-down list. 

4. Click Apply Changes. User group permissions for locations are updated. 

NOTE: To assign permissions to all user groups for a single location or multiple locations, check the All User Groups checkbox. 
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Setting Permissions for Cabinets 

The Config > Group Permissions > Cabinets page displays current cabinet names and user group names for viewing and 
assigning user group permission to cabinets.   

  

Assigning user group permissions to cabinets: 
1. Select the menu option Config > Group Permissions > Cabinets. 

2. Select Cabinets from the drop-down list. 

3. To grant permissions, check the corresponding checkboxes between individual cabinet names (on the left) and 
individual user group names (at the top).  

•  To deny permissions, clear the checkboxes as necessary.  

•  To view and assign permissions for a specific user group, select the user group name from 
     the pull-down list. 

4. Click Apply Changes. User group permissions for cabinets are updated. 

NOTE 1: To assign permissions to all user groups for a single cabinet or multiple cabinets, check the All User Groups checkbox. 
 

NOTE 2:  The screen sample above shows the cabinets RJF001 and RJF002 are not available to user group “Floor 2”. To make cabinets 
available to user groups, first the location where the cabinet resides must be made available to the user group at Config > Group Permissions > 
Locations. 
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Setting Permissions for CDUs 

The Config > Group Permissions > CDUs page displays current CDU names and user group names for viewing and 
assigning user group permission to CDUs.   

 

Assigning user group permissions to CDUs: 
1. Select the menu option Config > Group Permissions > CDUs. 

2. Select CDUs from the drop-down list. 

3. To grant permissions, check the corresponding checkboxes between individual CDU names (on the left) and 
individual user group names (at the top).  

•  To deny permissions, clear the checkboxes as necessary.  

•  To view and assign permissions for a specific user group, select the user group name from 
     the pull-down list. 

4. Click Apply Changes. User group permissions for CDUs are updated. 

NOTE 1: To assign permissions to all user groups for a single CDU or multiple CDUs, check the All User Groups checkbox. 
 

NOTE 2:  The screen sample above shows five CDUs that are not available to user group “Floor 2”. To make CDUs available to user groups, 
first the cabinet where the CDU resides must be made available to the user group at Config > Group Permissions > Cabinets. 
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Setting Permissions for Outlets 
The Config > Group Permissions > Outlets page displays current outlet names and user group names for viewing and 
assigning user group permission to outlets. The Outlets page refreshes automatically every 10 seconds.  

 

Assigning user group permissions to outlets: 
1. Select the menu option Config > Group Permissions > Outlets. 

2. Select Outlets from the drop-down list. 

3. To grant permissions, check the corresponding checkboxes between individual outlet names (on the left) and 
individual user group names (at the top).  

•  To deny permissions, clear the checkboxes as necessary.  

•  To view and assign permissions for a specific outlet, select the user group name from 
     the pull-down list. 

4. Click Apply Changes. User group permissions for outlets are updated. 

NOTE 1: To assign permissions to all user groups for a single outlet or multiple outlets, check the All User Groups checkbox. 
 

NOTE 2:  The screen sample above shows five outlets that are not available to user group “Floor 2”. To make outlets available to user groups, 
first the CDU where the outlet resides must be made available to the user group at Config > Group Permissions > CDUs. 
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Configuring Email Alerts 

The Config > Email page configures the email delivery of requested SPM system activity logs to a primary and secondary 
email address. 

 
As system activity occurs, requested logs can be emailed to configured email addresses. You can provide a primary 
recipient, a secondary recipient, or both primary and secondary. Primary and secondary addresses receive the same activity 
log alerts at the same time. 

User Groups 
Depending on the format of the send-to email addresses, you may send logs to primary and/or secondary user groups. 
When the status of a CDU changes (for example, from Normal to Warning), all users in the group are notified.  

To configure email delivery: 

1. Type the SMTP Hostname (or IP address) and SMTP port number in the boxes provided. 

2. Type the From address, and the primary/secondary To addresses. Make sure the addresses are a valid email 
format. 

3. Check the system logs to be delivered. Both primary and secondary email recipients receive the same selected 
logs. 

4. Click Apply.  
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Backing Up the SPM Database 

The Config > Backup page gives the administrator a database backup function that extracts SPM system data from the 
database and compresses the data to a file. 

 
To back up the SPM database, click Extract and Download Backup. The Backup feature creates the SPMDBackup.sti 
file for storage on the SPM appliance. If needed, the SPMDBackup.sti file can manually be used to restore the SPM 
database. 
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Setting Up the SPM Appliance 

The Config > Access page gives the administrator basic configuration options for setting up Sentry 
Power Manager as an appliance without the need to configure through the operating system. 

  

 
The Access feature lets SPM connect to, and communicate with, your current established network. Typical configuration 
of SPM is one IP connection turned on, however, there are two network cards on the SPM appliance: Network Port 1 and 
Network Port 2. Each network card can be used to connect to different networks. 

Connectivity Options 
The following connectivity options are available with the Access feature: 

• Web Configuration:  with a logged-in SPM user session (admn login only). 
• Serial Port Configuration: through the serial port located on the back of the SPM appliance. 
• Telnet Configuration:  by a Telnet application. 
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Telnet and Serial Connections 
• The Telnet and serial connections allow for a Reboot command and display the serial number  of the machine. 

• Modem cables are NULL (for serial connection) and standard (for Telnet connection). 

• The serial connection network parameters are: 

   Standard NULL modem cable 
   57600 bits per second 
   Data Bits = 8 
   Parity Bits = none 
   Stop Bit = 1 

• The default login name and password for Telnet and serial access is the same as the Sentry Power Manager web 
 default (username/password = admn/admn). Any administrative user created also has a working username and 
 password.   

• Changing the password of the admn login is strongly suggested and can only be done through 
        the web interface. 

• For Windows: the flow control value is the Windows default. 

• All SPM administrative user accounts created can login through the serial and Telnet 
 connections. 

Setting the System Hostname/IP Address: 
In the Hostname field, type a Hostname (or IP Address) and click Apply Changes.  

Setting the Network Port 1 IP Address: 
Select an option either to obtain the Network Port 1 IP address automatically through DHCP or to configure the IP address 
manually.  

If you choose the DHCP address, the IP Address (as provided by your DHCP server), Subnet Mask, and Gateway fields 
for the Network Port 1 populate with the assigned names. If you choose the manual address, the IP Address, Subnet Mask, 
and Gateway fields allow you to enter the desired entries.  

For both the automatic and manual options, save data by clicking Apply Changes. 

Setting the Network Port 2 IP Address: 
By default Network Port 2 is disabled. To enable, select one of the following options: 

•  Obtain the Network Port 2 IP address automatically through DHCP 

•  Configure the IP address manually  

If you choose the DHCP address, the IP Address (as provided by your DHCP server), Subnet Mask, and Gateway fields 
for the Network Port 1 populate with the assigned names. If you choose the manual address, the IP Address, Subnet Mask, 
and Gateway fields allow you to enter the desired entries.  

For both the automatic and manual options, save data by clicking Apply Changes. 

Setting the Web Port Number: 
Type the desired Web Port number and click Apply Changes. 

Enabling Telnet Access 
To enable Telnet access, check the Enable Telnet Access checkbox. Accept the displayed number in the Telnet Port field 
or type over the number, and click Apply Changes. 

Enabling Serial Access: 
To enable Serial port access, check the Enable Serial Access checkbox and click Apply Changes. 

Enabling Database ODBC Access (Optional): 
To enable Database ODBC Access, check the Enable DB Access checkbox. Accept the displayed number in the DB Port 
field or type over the number, and click Apply Changes. 

NOTE: If ODBC has not been purchased separately and turned on by a SPM validation key, the Database “Enable DB Access” dialog box will 
not be available on the Access page. 
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Getting Help for SPM 

The following options are available on the Help menu for technical information and product support: 

Help Menu Options  
Option  Description 

Support  Contact information for SMARTER Technical Support and links to this user operations manual at Server
 Technology’s website.. 

Licenses  (Administrator only) Allows update for an additional SPM license key; also displays  current SPM release 
number and the current number of supported CDUs, and other  enabled features. 

Support 
The Help > Support option shows contact information for Server Technology’s SMARTER Technical Support. In addition, 
links are provided to the Server Technology website and to the Sentry Power Manager – Operations Manual. 
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SPM License Page 

For the administrator: The Help > Licenses option allows the administrator to update to an additional SPM license key 
that supports more CDUs in the network. The page also displays the current SPM release number and the number of CDUs 
supported under the current license key. The page also shows if the Billing reports feature is enabled. 

 
 

Click the Enter Additional License Keys button to display the following page: 

 

To apply a new SPM license key: 
1. Obtain the new license key from you Server Technology Account Representative at 800.835.1515 (domestic) or 

+00 (1) 775.284.2000 (international). An alpha-numeric key will be generated for you based on the serial number 
of the appliance that contains SPM. 

2. Type the new key you receive in the Key field and click Add. 

NOTE: To purchase additional Sentry Power Manager SPM Licenses, please contact your Server Technology representative at 1-800-835-1515 
(domestic), ++0 (1) 775.284.2000 (international), or sales@servertech.com. 
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Chapter 4: Appendices  
Appendix A: Technical Specifications 

Regulatory Compliance 
Products with the following mark comply with the RoHS Directive (2002/95/EC) issued by the 
Commission of the European Community. 

Recycling 
Server Technology Inc. encourages the recycling of its products.  Disposal facilities, environmental conditions 
and regulations vary across local, state and country jurisdictions, so Server Technology encourages consultation 
with qualified professional and applicable regulations and authorities within your region to ensure proper 
disposal. 

Waste Electrical and Electronic Equipment (WEEE) 
In the European Union, this label indicates that this product should not be disposed of with household waste.  It 
should be deposited at an appropriate facility to enable recovery and recycling. 

For information on how to recycle this product responsibly in your country, please visit: 
www.servertech.com/support/recycling. 

Appendix B: Warranty, Product Registration, and Technical Support  
Warranty 

For Server Technology Warranty information, please see our website. 

Product Registration 
Registration is your key to special offers and services reserved for Registered Users. 

• Excellent Technical Support Services 
• Special Update and Upgrade Programs 
• Warranty Protection 
• Extended Warranty Service 
• New Product Information 

Register your products online today!

Technical Support 

 
Experience Server Technology's FREE SMARTER Technical Support - Learn more...

Server Technology understands that there are often questions when installing and/or using a new product.  Free Technical 
Support is provided from 6:00 AM to 7:00 PM, Monday-Friday, Pacific Time. 

Server Technology, Inc. 
1040 Sandhill Drive Tel: 775.284.2000 Web: www.servertech.com 
Reno, Nevada  89521 USA Fax:  775.284.2065 Email: support@servertech.com 

Return Merchandise Authorization 
If you have a unit that is not functioning properly and is in need of technical assistance or repair: 

Please review Server Technology’s Return Merchandise Authorization process on our website. 
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